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PDS v9 New Features

View Menu

Piece List (View > Piece > Piece List) — Used to edit all the pieces details including reporting to Excel and layout parameters
“View” dialog was improved. Many more detailed selections (F10).
Compare Length dialog became more flexible. By Straight, By X, and By Y were added.

Seam Menu

Seam:

- Seam algorithm was changed. You can change the seam for a specific segment.

-The “Re-seam Segment Only” command will work only if the start/end point of the selected segment are ‘grading - non curve’ points.
When dealing with positive seam, the best way to operate this tool is to select a segment between two turn points (a point where the
segment changes direction). Use this option to recalculate seam value in a specific segment (for working without Auto Re-seam).
Reform seam to internal sew contour / Reform internal contour to seam options. This feature can be used especially after importing
files in AAMA / ASTM formats.

Dialog for correction seam values of points in seam dialog.

After adding seam to a piece you can modify a specific segment’s seam by taking the seam tool and choosing a segment with it (point
to point in clockwise direction). Make a variable seam and change each point.

Remove Seam on Segment (Seam > Remove Seam on Segment)

This option will delete the seam on the selected segment. You have to choose a specific segment first, and then click on this option.
Set Primitive Seam (Seam - Set Primitive Seam)

This option enables you to define Seam value to all the pieces in the file/working area in one single command.

Design Menu

‘Equal Segments’ and ‘Point Connection’ in templates.

You can create a new shape and define on the shape two segments to be equal.

Then the shape can be saved as a template .You can open this template any time you want and copy & paste it on the working area —
this way you’ll get a piece with equal segments.

The same thing can be done also with ‘Point Connection’ option.

‘Create Piece from Arc’ (Design - Piece from Arc). — Can be used for designing Brassieres.

Choose the arc segment you want to create piece from.

‘Extend Parallel’ option.

You can access this option thru ‘Design’ = ‘Extend Parallel’, after you choose a segment.

Arrange For Plot became more flexible (“Ctrl + A” will do arrange for plot for scattered pieces and “Ctrl + Shift +A” will do arrange for
plot for the pieces on the working area only)

“Length” parameter was added to set the frame size for Plotters / Cutters that use frames.

Cut By Guide Line — (Design - Cut > Cut by Guide Line), this option will cut the piece in the place where the guideline is.

Cut Parallel (“Design” menu - Cut = Cut Parallel)

Options Menu

Colors definition became much more flexible and new features were added to it. Including line thickness and Tool definition for line
types (dash, dash dot, etc.)

Filling colors to pieces (Options > Preferences > Filling or Ctrl + F) set the view attributes of the pieces so that you see the all,
selected, or no pieces with color filling. Also you can hide selection rectangle with a filled selected piece.

Track Lines — Choose to view “track lines” of all the manipulation you do with the piece’s contour. You can turn this option on thru
“Options” = “Track Lines”.

You can clear all Track lines thru “Options” = “Track Lines” = “Clear Track Lines”.

This option is very good for tracking changes you make with the piece’s shape giving the ability to go back to original shape (“Options”
- “Restore by Track Lines”)

Auto Save

When you define “Auto Save” option from “Options” = “Preferences”, the program checks if the “Backup.dsn” file exists, and if it's not
you must create it.

New working units were added to the “Working Units” dialog: Meters, Feet, Yards

Preferences dialog (Options - Preferences)



-Filling — Enables color filling for selected piece (Ctrl + F), accessible thru View menu too.

-Create Track Lines — Enables track lines creation (Ctrl + Alt + T).

-Test empty/duplicate piece names in creating — When saving the file, the program checks if there is a piece without a name or some
pieces with the same name and will offer to fix it.

-Allows Snap to invisible objects — You can snap to points/objects even if they are not visible.

-Show all moving internals — When using “Move Internal” tool and more then one internal object is selected then you can choose if you want
to see all the internals moving during the Drag command or just the selected one. In any case the result will be that all the internals will
move.

- Create Center Button — Creates a button in the center of a new piece (good for pieces shaped like circles).

- Add Point with New notch — This will create a point on every new notch you’ll create.

- XML - style header - Will create the “.DSN” files with XML header which is important for systems that can Import XML file format.

- Filling in Piece Bar — Will present the pieces in the piece bar with color filling.

- One Track Line for Segment Only — Will enable only one track-line to be created to every segment.

- Duplicate text in Mirror — Will enable/disable text duplication in both sides of the mirror line.

File Menu

e Import / Export module — In Version 9 you can import and export in ASTM format in addition to all other formats that were used in
Version 8.

¢ Import dialog became more flexible (File > Data Exchange - Import...).

e Export module (File > Data Exchange = Export...)

Export files in XML format. This is used with TPDM systems and other systems that can Import XML format. If you have more than one
piece in the file, you'll get a dialog for choosing whether you want to export one piece or all the pieces in the file:

e Batch (File > Batch - Start Batch)

In Version 9 you can run Batch scripts just like in the Marker.

e Import
Import from Gerber cutter can be done with block separation, this way every block gets a specific name and becomes a piece by itself.

e In Version 9 when you attempt to “Save”/"Save as” a file with absent piece name or with duplicate piece names, you'll get the following
dialog which will ask you if you want the program to fix the problem automatically.

e ‘“Save Separately” (File > File Utilities > Save Separately...) option enables you to save selected piece as a single style file or save
all pieces on the file as a single style file for every piece (the program will create a directory with the name of the file and in it there will
be created all the style files for every single piece).

This option is very good for managing patterns database.

e Customize Excel report — in version 9 you have the ability to choose the information you want to be presented in the report.

¢ Plot dialog has changed (File - Plot >Plot)

-M19 command — Disable “overcut” and “heelcut” (used on slit notches).

-Heelcut — advance before plunge (pen down).

-Overcut — to cut also the top of a slit notch:

-Note: M19 command will be shown in the ASCII file only if the notch cutting attribute is “While Cutting”.

-Cut Darts — This option will give the cutter a command to cut the lines of the dart. Without this option the cutter will continue cutting the

external contour (won’t cut the dart).

-No Draw — Checking this option will not send information about internal elements with draw attribute. This option is good for cutters with no

pen head (only knife).

Edit Menu

e Align Points dialog in Ver 9 was improved (Edit > Contour - Align Points).
e New shapes were added to ‘Make Piece’ command (‘Edit’ > ‘Make Pieces’).
“Spiral” shape is used in the garment industry for producing ribbons.
e “Extend Contour As Curve” - Choose a segment; select “Extend Contour as Curve” from “Edit” menu.
e Set Point Angle (Edit > Contour = Set Angle)
You can choose a point and set an angle to it. You can define a deferent angle for every size if the piece is graded.
e Move Dart option was changed (Edit menu > Move Dart)
¢ Smooth Segment (Edit > Contour - Smooth Segment)
Choose a segment (between two grading points), go to “Edit” > “Contour” > “Smooth Segment”.
e Extend Internal (Edit > Contour > Extend Internal)
If you have an internal contour shaped like the internal contour in the following bitmap, you can choose to which segment you want to
extend the point.
¢ Round Corner (“Edit” Menu = Contour = Round Corner)
- Select a point on the contour and click this tool. Enter the desired radius you want to assign to this point and click OK.
e Select All — Select all Pieces
e All To Working Area - place all pieces on desktop at once
e Copy and Paste segment (“Edit” menu - Segment = Copy)

Grading Menu

e ‘Sizes to Pieces’ option.

If you have a graded piece, you can separate all the sizes to pieces by clicking ‘Grading’ - ‘Sizes to Pieces’.
e ‘Parallel Grading’

Grade an entire segment as well as a point. (First define sizes and choose a segment).

You can access this function thru ‘Grading’ - ‘Parallel Grading’.

‘Paste Grading Around’ (Grading - Paste Grading - Paste Around)



After you copy a grading rule from one point, you can paste the grading rule with equal values from all around the piece (it will grade
also the non grading points), and not only from grading points.
“Grade By Seam” option (Grading > Grade By Seam)
After defining a seam and sizes, you can grade the piece according to the seam’s value.
The system will take the value of the seam and create grading according to this value on all the sizes you defined.
Sizes Tree (Access thru “Grading” - “Sizes Tree”)
In Ver 9 you can view all sizes of piece (if it's graded)
Sizes Table — You can click “Use Sizes Table” thru “Sizes” dialog and choose which sizes you want to participate in the “Variation
Grading” function.

Dart Menu

Open / Close dart (choose the Dart and click “Dart” menu - “Edit Dart”/”Close Dart”)
Dart -In Ver 9 we added a new dart attribute — “Cutting Dart”. Create a dart and click “Cutting Dart” thru “Darts” menu.

Piece Menu

Mirror-In Ver 9 you can define a segment as a mirror line even if it has points between the segments begin and end point.

Set Half option (Piece - Modify > Set Half)

In Ver 9 you can define in the piece’s attributes “Set Half” option. This will allow you to work only on one half of the piece and when the
marker reads the piece it opens the piece.

Choose a segment you want to act as a Half Piece line (the segment should contain only two points — first and end).

“Fill By Current” — new option in the global piece info dialog (Piece - Global Info).

Scale and Shrink (Piece > Modify - Scale and Shrink)

New option was added to the “Scale and Shrink” dialog. Now you can do “Scale and Shrink” for selected segment only.

Create parallel guide lines

Choose a segment and click “Piece” menu > “Guideline Parallel”.

Pleats Menu

Multi Pleat (Select a segment and access this function thru “Pleats” > “Multi Pleat”).

In Ver 9 you can create Multi Pleat in the same way you create Multi Dart.

You can close the pleat and open it again in order to see how the piece will look like with/without pleat.
Double click on a pleat line will open up the dialog box

Tools, Commands and general info

Add point option in “Rotate Segment” dialog.

Notches-In Ver 9 there is a new Notch algorithm, which enables mirror pieces with the exact notch direction on the mirrored segment.
In import, PDS 9 recognizes ‘I' and ‘T’ notches as well as V' notches (Ver 8) from a variety of file formats (dxf , gbr, hpgl etc.) .
Walk Option

In Ver 9 you can use the ‘Walk’ option also with ‘Notch’ on ‘Notch’ or ‘Notch’ on point etc.

Another feature is the ability to switch ‘walking’ to another stationary piece by clicking the ‘Tab’ button.

‘Mirrored’ field was added to piece info dialog.

‘Notch on Point’ option more flexible.

You can choose the notch’s direction by clicking OK button + Ctrl/Shift.

‘Guide Lines’ can be visible or not using Shift + Alt + G

‘Rotate’ dialog in Ver 9 is much more flexible then in Ver 8.

Notch dialog was changed: New features were added to it.

Multiple Selection

You can drag a window around the pieces you want to select and move them clicking the left mouse button.

This will move all the pieces you selected.

Build Piece option

In Version 9 Build Piece can be done with guidelines too.

Create Arc tool

You can create an arc out of any segment. Also used for smoothing a segment.

To select this tool click on the following icon:

Select the segment clockwise with the tool and you'll see the arc manipulation.

To set the arc click again with the mouse left button.

In order to deform the arc’s shape manipulate it by pressing “Shift”.

Move Points tool

Choose a segment with the “Move Points” tool. Try to move one of the points on the segment you selected and click on left mouse
button. If you click “Shift’ button in addition, all the points will be moved. Without the “Shift” button only Grading points will be moved.
This will open the following dialog:

Move Point Along Contour dialog has changed

Join Pieces became more flexible.

You can decide in which direction the “Join” command should work.

Reverse Angles buttons in “Draft” dialog.

Move Piece — In Version 9 you can point with the cursor on a piece and drag it (with the left mouse button clicked) to a new location.



e Copy Internals — You can copy internal elements in the same piece by clicking “Ctrl” + “Move Internals” tool on the desired internal
element. You have to push the “Ctrl” button until the end of the process (the Paste command). If you want to copy an internal element
from one piece to another just drag it to the destination piece with the “Move Internals” tool (no need to click “Ctrl”).

e Zoom In/Zoom Out — you can zoom in/out during any command you are in (trace segments, build piece, etc.) by clicking on the ‘-*/
‘+’ signs on your keyboard..

e Browse along the piece — you can browse along the piece during command like “Trace Segments” with the directional arrows < , >
(also up and down).

e Cut Seam Angle
- This tool enables you to define any angle you want for seam corner without being affected by ‘Re-seam’ command.

¢ Move Point Tool
When clicking on “Shift” + “Move Point Tool” on a contour, a curve point will be created.

If you use this tool without “Shift” button, a regular point will be created.

e  Trim Function
- With this tool you can trim two internal lines in their intersection point.

e Trim and Cut
- This tool acts a little differently from the previous one:

Use this tool to choose the segments you want to keep (instead of delete in the previous tool).
It also extends two internal lines up to their intersection point:

e  Multi Move
- This tool enables you to move several points/contours by selecting them with a selection rectangle.

e Wave

- Use this option to create a contour shaped like sinus.
You can increase/decrease the number of sinus cycles by clicking on “TAB” button during the Wave process.

e Print command
In PDS 9 you can print the working area as is, even if the line type is dash/dash-dot.

¢ - Rotate Piece/Contour
There is an option to change the rotation center point of a piece.

If the “Rotate Piece/Contour” tool is selected while clicking on “Ctrl” button then the rotation point will be the end point of the selected
segment.

e - Button on Distance
In addition to its traditional functionality (add an array of buttons), if you select this tool when the SHIFT button is clicked you'll be able
to add an array of lines in equal distances one from each other. This option was made for the upholstery industry.

Import Setup Dialog

Tolerance The Tolerance Value determines the farthest distance two points on a contour can be placed apart and still be treated as the
same perimeter (SGS software usually handles only properly closed contours. However, the tolerance value ensures that contours that are
not closed properly will be read).

Bulge Chord Error Bulge Chord Error is a parameter used to define the smoothness of Curves and Arcs. A smaller value creates many
additional points and segments within the piece.

Objects Area Bottom Restrictions

Piece - If a piece boundary is smaller than the value defined in this box, the Import command disregards the piece and throws the piece
away.

Hole - A hole is a closed contour on the same layer as the piece boundary. Use this area to define the minimum size of a hole. The
minimum area of a hole should be smaller than the smallest piece.

Spline Angle The smallest angle for curved lines.

Max Grade Angle The maximum angle for a graded nest.
Default Internals Sizes

Button - The actual size of the + sign on the button.

Notch Depth - The height of the notch in working units.

Notch Width - The width of the notch cannot exceed its length.

Text Size - Text size for the marker. If a text size was defined in the imported file, SGS software maintains that value. Text is information
typed directly onto the piece. Piece Description Text Is defined using the Dictionary dialog box.

Min Circle (Max. Button) Radius The smallest size of an internal circle. The greater size of button radius.
Max Notch Ratio The largest difference when dividing the width by the depth of the notch.

Max Notch Depth The maximum depth for a notch.

V Notch’s Recognizing Parameters

Max. Internal Angle - This area is used to define the maximum angle of a V notch.

Max. Relative angle - This area is used to define the smallest near angle of a V notch.

Convert Internals Point on External Contour to Notch Checking the box will convert every internal point on the external contour to notch
in the imported file.

Options



Ignore CR / LF Mainly for CNC files which come in one long line, or use a CR/LF after each point. When enabled, the Carriage Return/Line
Feed in the import file is ignored.

Ignore Frame SGS software ignores the outer frame (boundary) which is usually created for Plot files

Separate Layers SGS software remembers the layer of each element. If the new file is ever exported, the elements keep their original
layers. This option is used only for DXF and AAMA files. Because SGS software recognizes elements and text on different layers, a circle
inside a shape may make a noticeable difference in the imported file. If the circle is imported while the Separate Layers option is disabled,
the circle becomes a simple internal element. If the circle is to be recognized as a hole, it must be on the same layer as the outer perimeter
line. Or, the DXF file can be imported with the Separate Layers option in the OFF position.

Separate DXF Blocks There are some CAD systems (like AutoCAD) that treat a group of entities (like lines) as a block (like piece).In this
case, the syntax of the “.DXF” file will be different. OptiTex can read this specific file structure if this option is checked.

Choose Starting Points of Pieces When import a DXF file. The OptiTex software gives the option to choose what will be starting point of
the pieces that will be import. When this box selected the starting point will be the sharpest angle at the imported piece.

Box Without Margin The “Import Box” mode imports the piece with a margin (space) between the blocking rectangle and the piece
contour. Checking this option, will disable the margin when doing “Import” in “Box” mode.

Allow Empty Rules for External/Internal Contour Points This option is meant to be used when importing a file with points that have a
grading value that is not shown in the grading table. For OptiTex it means “Empty Grading”.

All Turn Points are also Grade(ASTM)

“Turn” points means “non curve” points. This option is recommended when working without sizes (one size only). Checking this option ‘On’
will help the program with special attributes like Notches etc.

Internal Points on Contour

This option work only when the imported file is in DXF format.

Ignore points without radius value — Points with no radius value will not be imported.

Ignore points on contour vertexes — Points outside of the external contour or on the top will not be imported

Auto Recognition Internal Elements

Convert the longest line to baseline — OptiTex will recognize the longest internal line and will import it as a baseline

Check on-contour v-notches in AAMA file - OptiTex will check for v notches on the contour and will import them as notches.

Relate All External Text to the Single Piece — This option is used for importing files that were exported from other CAD systems (like
AutoCAD) in “.dxf" mode where there is no relationship between the piece and the text in the file. When importing a file with only one piece
the program will relate all the text in this file to this piece. This option is not good for multiple pieces file since there is no way of knowing
which text belongs to which piece.

Stripe Adjust Point Number to Set - Enter the desire number to the strip adjust number if the imported file contains any. The numbers can
be between 1 and 9.

ASCIl Symbols for Drill (HPGL) In some cases, when producing an HPGL file from a Gerber system, drill holes may be indicated by
‘X’ character or ‘0’ character. If in import box process you recognize one of these signs try to check if these are internal lines indicating a
character sign or an internal text. If it is an internal text, you can put in the text field the letter representing this character and drill holes will
be recognized more accurately.

Recognize Pieces Descriptions From Internal Text The OptiTex program can import the piece description as an internal text. Choose
the type of text that will be import.

Recognize size Names from Internal Text This command gives size name from the internal text of the imported file. Choose "yes" to
active this command. Choose the number of symbols in range between 1-7.

Gerber Cutter Set Piece Name by Block Number — in a “.gbr” file the syntax is very specific. Every piece is described with a block name
and then the piece info. Checking this option will give all pieces the name of the block that encapsulates its information in the file.



Marker 9 New Features

Unlimited number of different pieces in “Order” and “Placed On Marker”.

Unlimited length for Piece names, descriptions and Size names.

“Spread Pieces” window is dock able.

View / Unview ruler (View = Ruler) - In Mark 9 you can choose to view a ruler in the bottom of the Marker.

New export format — XML.

New parameters were added to “Preferences” dialog (Options > Preferences)

“Status Line” tab: Option to choose marker length presentation in status line.

New option in “Plot” dialog. You can plot Marker header prior the Marker and after the Marker at the same plot.

New command to align pieces with arrangement (Marker - Alignment - Custom).

New “semi — manual” Nesting features — “Auto Nesting piece by piece” and “Fill Column”.

Auto Nesting Piece By Piece: When you choose this option and click on SHIFT button, the pieces will be nested in a straight columns,
and the program will try to fill empty spaces with the rest of the pieces.

A more flexible snapping in measure tool. Snapping to Notches, Buttons and Bump Lines. The snap command will work when you click
on right mouse button near a notch/point etc.

“Exclusive View” option was added to “Internals” dialog and to “Global Change Internal Parameters”. It allows defining internal to be
shown (plotted, exported) for one side only of opposite pieces.

Excel Reports Customization (File - Customize Excel Report). This dialog enables you to define/edit which details you want to be
included in the report. You can mark the fields you would like to be included in the report, and also you can edit the header key words.

“Colors” dialog was changed and improved.

“Piece List” became interactive and customable. It can work as Global info or as all sizes info dialogs.

Compact Arrangement — Now you can select several pieces on the Marker and perform compact arrangement for them.

New cost calculations dialog (Marker > Cost Calculations)

New option in buffer definition — you can define partial buffer near marker edges.

Ability to print text on Marker background. It works with regular text dialog.
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